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Creating and managing catalogs

This guide is for Ariba Network suppliers and describes how to create, upload, and manage catalogs of the 
products and services that their company offers.

Catalogs are text files that describe the products and services offered by suppliers. Suppliers publish catalogs on 
the Ariba Network for customers to subscribe to.

This guide applies to:

● Ariba Network

Related guides

Catalog format reference
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Ariba Network is now part of SAP Business 
Network

What is SAP Business Network?

SAP Business Network is a cloud-based collaboration offering that can help you transform disconnected supply 
chains into unified, collaborative, and intelligent networks that remove barriers and centralize data.

With a unified network, you can connect to all trading partners through a single directory, collaborate using shared 
data and workflows, and apply network-wide intelligence to guide decisions and improve your business.

Is SAP Business Network a new or different network?

No; SAP Business Network is the new solution name for the trading partner portal that all Ariba Network suppliers 
use as part of SAP's unified network vision. The transaction network behind the portal remains branded as Ariba, 
and remains operated by Ariba Inc. (a wholly owned subsidiary of SAP SE).

What exactly is renamed to SAP Business Network and what stays Ariba Network?

Two supplier experiences are renamed as SAP Business Network: the trading relationship request invitation-based 
onboarding for enterprise accounts, and the supplier homepage and workbench for all enterprise and standard 
accounts. All other network experiences remain branded with Ariba Network or SAP Ariba Supply Chain 
Collaboration.

Creating and managing catalogs
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New menus for the 2105 release

The Ariba Network Inbox and Outbox have been replaced with object-oriented menus for all buyers and suppliers. 
Menu items are now grouped logically by process, improving navigation and usability.

User interface changes for suppliers

The following table describes previous menu paths for suppliers and their counterpart in the new object-oriented 
menus.

Old menu New menu

Home Home

Inbox Orders and Releases For suppliers without SAP Ariba Supply Chain Collaboration: 

Orders Purchase Orders

For suppliers with SAP Ariba Supply Chain Collaboration: 

Orders Orders and Releases

Inbox Extended Collaboration Fulfillment Extended Collaboration

Inbox Collaboration Requests Opportunities Collaboration Requests

Inbox Time and Expense Sheet Fulfillment Time and Expense Sheet

Inbox Transport Requests Fulfillment Transport Requests

Inbox Early Payments Payments Early Payments

Inbox Scheduled Payments Payments Scheduled Payments

Inbox Remittances Payments Remittances

Inbox Contracts Orders Contracts

Inbox Notifications ... Notifications , in the Track section.

Inbox Receipts Fulfillment Goods Receipts

Inbox Pending Queue ... Pending Queue , in the Track section.

Inbox Product Activity ... Product Activity Messages , in the Track section.

Inbox Inquiries Orders Order Inquiries

Outbox Invoices Invoices Invoices
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Old menu New menu

Outbox Timestamp Verification Invoices Timestamp Verification

Outbox Order Confirmations Fulfillment Order Confirmations

Outbox Ship Notices Fulfillment Ship Notices

Outbox Transport Confirmations Fulfillment Transport Confirmations

Outbox Service Sheets Fulfillment Service Sheets

Outbox AP Plus Transactions Payments AP Plus Transactions

Outbox Archived Invoices Invoices Archived Invoices

For ship notice and service sheet drafts, Outbox Drafts Fulfillment Drafts

Outbox Sales Orders Fulfillment Sales Orders

Outbox PDF Conversion Invoices PDF Conversion

Outbox Product Replenishment Fulfillment Product Replenishment

Outbox Extended Collaboration Fulfillment Extended Collaboration

Outbox Documents to resend ... Documents to Resend , in the Track section.

Catalogs Catalogs

Enablement Tasks Enablement

Reports Reports

Document Archive Archived Documents ... Archived Documents , in the Document Archive 
section.

Document Archive Download Status ... Download Status , in the Document Archive section.

Messages Messages

Planning Forecast Planning Forecast

Planning Planning Collaboration Planning Planning Collaboration

Planning Sales Report Planning Sales Report

Documents ...

Documents Order Confirmation CSV ... Order Confirmation , in the CSV Upload section.

Documents Ship Notice CSV ... Ship Notice , in the CSV Upload section.

Documents CSV Templates ... Templates , in the CSV Download section.

Documents Invoice CSV ... Invoice , in the CSV Upload section.

Documents Service Entry Sheet CSV ... Service Entry Sheet , in the CSV Upload section

Documents PDF Invoice ... PDF Invoice , in the CSV Upload section.
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Old menu New menu

Documents External Document ... External Document , in the CSV Upload section.

Documents PO Invoice Create PO Invoice

Documents Non-PO Invoice Create Non-PO Invoice

Documents Contract Invoice Create Contract Invoice

Documents Service Entry Sheet Create Service Entry Sheet

Documents Time & Expense Sheets Create Time & Expense Sheets

File Downloads ... Upload/Download , in the Excel Files section.

For invoice drafts, Outbox Drafts Invoices Drafts

Outbox Invoices , filter by Credit Memos Invoices Credit Memos

Outbox Invoices , filter by Debit Memos Invoices Debit Memos
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Getting started with catalogs

Catalogs are text files stored on Ariba Network or on your own company’s website that describe the products and 
services your organization offers and the prices you charge. You can create catalogs for any product or service, 
regardless of how it is measured, priced, or delivered.

Your customers access your catalogs through their procurement solutions to see what you offer and to make 
purchases from you. Catalogs are the main communication channel between you and your customers.

Ariba Network supports the following catalog types:

● CIF (Catalog Interchange Format): You can create CIF catalogs [page 32] with any word processor, text 
editor, or spreadsheet application.

● cXML (Commerce eXtensible Markup Language) format: You can create cXML catalogs using any XML or 
text editor.

● PunchOut catalogs: PunchOut catalogs [page 35] are interactive catalogs that use cXML to support two-way 
communication of electronic commerce details. A PunchOut catalog resides on your website; you provide your 
customers with a URL with which to access it.

● BMEcat (Bundesverband Materialwirtschaft, Einkauf und Logistik e. V. catalog): You can publish BMEcat 
catalogs [page 17] only to customers who use the content management system (CMS) in SAP Ariba 
solutions to manage their catalogs.

● Excel (Microsoft Excel): You can publish Excel catalogs [page 17] only to customers who use the content 
management system (CMS) in SAP Ariba solutions to manage their catalogs.

Ariba Network supports any catalog in CIF or cXML format. A CIF catalog can be either a text file saved with a .cif 
extension or an Excel file saved with a .xls extension. You can upload a catalog using either the Ariba Network 
catalog wizard or the cXML CatalogUploadRequest transaction. The cXML CatalogUploadRequest 
transaction supports CIF, cXML, BMEcat, and Excel catalogs. It also supports both new catalogs and updates to 
existing catalogs.

For help in deciding which catalog format is best for your company, see the Catalog format reference.

Catalog workflow
The following is a typical example of the interaction between catalogs and your customer's purchasing solution:

1. You create catalog files [page 14] that describe products and services. You can download the CIF file template 
[page 32] or the CIF and CXML example files that are available in the Ariba Network catalog wizard to create 
catalogs.

2. You specify how to publish the catalog. In the Ariba Network catalog wizard, you:
1. Designate a catalog as either private or public.
2. View your customer’s catalog preferences [page 22].

3. You upload the catalog files for a customer that has an active trading relationship on Ariba Network. If your 
account is suspended, you can't publish catalogs to specific customers. Ariba Network doesn't show your 
customers at the bottom of this page.

Creating and managing catalogs
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After the catalogs are validated, Ariba Network publishes them to customers. You can verify the status [page 
22] for your uploaded catalogs.

4. If your uploaded catalog has errors, correct the errors [page 25], and upload the catalog again.
5. Ariba Network notifies the customer by email that new catalogs are available.
6. Your customer’s purchasing site downloads and approves catalogs for use.
7. Users in your customer's organization browse the catalogs for products and services and initiate purchase 

requisitions, which are routed through their organizations for approval.
8. Upon approval, the purchasing site automatically sends purchase orders to Ariba Network.

Benefits of uploading catalogs
Storing your catalogs on Ariba Network provides the following benefits:

● Security: Ariba Network offers robust catalog security. After you upload catalogs, you publish them to 
individual customers or groups of customers. No other customers or suppliers can see them.
For additional security, Ariba Network uses Secure Hypertext Transfer Protocol (HTTPS) so catalogs are 
encrypted across the Internet. Ariba Network also uses HTTPS when customers download catalogs.

● Versioning: Ariba Network stores all versions of your catalogs, so you don't have to maintain local copies on 
your computer. Catalog versions are maintained on a "last in/first out" basis. When you upload a new catalog 
version, Ariba Network maintains it as the current version. When you delete a version, Ariba Network removes 
the most recently uploaded catalog.

 Note
While uploading a catalog, you must ensure that you always use the same filename for all versions of the 
selected catalog. Using the same name makes catalog management easier for customers.

 Note
Catalogs published for CMS-enabled customers [page 17] aren't stored on Ariba Network.

Making catalogs available to your customers
After you create your CIF or cXML catalog, you store it on Ariba Network and publish it to your customers. Your 
catalogs don't automatically appear in your customers’ purchasing systems immediately after you publish them.

Your customer’s administrator must first validate, approve and activate catalogs before users can view them. A 
catalog subscription creates a link between your customer and your catalog so that you can send updated versions 
directly to your customer’s purchasing system.
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Catalog notifications
If customers request notification of catalog changes, any future modification you make to that catalog 
automatically triggers another notification to the customer.

For private catalogs, customers receive notification only if you select them and they request notification. 
Customers that you don't select won't receive notification, even if they request it.

Publishing a catalog sends an automatic notification to the selected customer. Customers can download catalogs 
manually from Ariba Network, or you can set up subscriptions so that Ariba Network automatically updates your 
customer’s existing catalogs when new versions are available.

Catalog expiration and deletion
Catalogs that have never been published and contain more than one version expire 180 days after they were last 
viewed by the supplier. If a catalog has been published or contains only one version, it never expires.

When Ariba Network deletes catalogs, it deletes them permanently. There is no way to retrieve deleted catalogs, 
either through the Ariba Network user interface or by contacting SAP Ariba.

Deleting a catalog from Ariba Network doesn't delete the catalog from your customer’s purchasing system. 
Customers that previously downloaded these catalogs and imported them into their purchasing system can still 
use them. To ensure that customers don't continue to use old catalogs, add an expiration date to your catalogs 
(available in CIF 3.0 and cXML catalog formats).

Test catalogs
Test accounts are optional and complementary Ariba Network accounts that allow customers and suppliers to test 
catalogs and purchase order generation, routing, and receiving.

Test accounts enable transaction partners to send and receive test purchase orders without the risk of actually 
shipping products or disrupting production transactions.

The catalog tester, which is available only in your test account, lets you see how a customer would see the catalog 
contents. You can examine your item descriptions and other catalog fields to see how they appear. You can choose 
catalog items and add them to test purchase orders. You can also submit these test purchase orders to exercise the 
order routing method you configure in your test account.

For more information on test accounts, search for Using test accounts in Ariba Network in the help 
center.

 Note
You cannot test catalogs published for customers who use the content management system (CMS) available in 
SAP Ariba Procurement solutions to manage their catalog data.

Creating and managing catalogs
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Accessing pricing and availability updates

If your customer’s purchasing site supports PunchOut catalogs in both CIF and cXML formats, your customers can 
go directly to your website to search for and choose items and services.

In the case of a PunchOut item, the customer can click a link to punch out directly to your website and receive live 
pricing and customer-specific information.

Level 2 PunchOut enables customers to search for and find PunchOut items within their purchasing site, instead of 
having to search your website directly.

If you use Level 2 PunchOut, Ariba Network allows you to configure and specify a cXML URL for pricing updates, 
where customers can request for updates on price and availability of catalog items. After you have published a 
catalog on Ariba Network, you might change the price or availability of your catalog items. However, your published 
catalog continues to show the older information on Ariba Network until you upload a newer version of the catalog. 
When you configure a cXML URL for the price and availability updates, customers can view the updated prices of 
catalog items in their purchasing site.

Maintaining catalog versions for different customers

Customers that use SAP Ariba Buying solutions can define catalog validation rules to support unique codes in their 
purchasing systems.

You might have customers using a unique set of Unit of Measure (UOM) codes or commodity codes in SAP Ariba 
Buying solutions. Ariba Network supports customer-specific catalog validation rules [page 22] and transforms the 
values provided by the customer to the equivalent values supported by Ariba Network. This greatly eliminates the 
need for suppliers to maintain separate catalogs to support a different set of UOM, country code, commodity code, 
and currency code values for each customer. Suppliers can use a single set of values for the catalog each time an 
update is made.

For example, customer A supports “Each” as the UOM code and customer B supports “EA." The supplier supports 
“Each” as the UOM code. In order to support both the customers, the supplier had to create and maintain two sets 
of catalogs for these UOM codes. Ariba Network allows customers of SAP Ariba Buying solutions to define specific 
catalog validation rules that allow suppliers to maintain a single set of UOM code to support both these customers. 
Using the catalog rules specified in SAP Ariba Buying solutions, SAP Ariba transforms the UOM code “EA” to 
“Each” allowing both the customers to receive their value of the UOM code each time the catalog is updated.

Additional resources

The following table lists the resources available for catalog creation:
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If you want to… See this guide…

Create CIF or cXML catalogs Catalog format reference (available in the help center)

Explains how to work with the CIF (Catalog Interchange Format) 3.0 and cXML (com
merce eXtensible Markup Language) catalog formats. It also describes how to use cat
alog features to reflect your business model and to differentiate your product and serv
ice content.

Implement a PunchOut website cXML Solutions Guide (available in the help center)

Describes how to implement a PunchOut-enabled website, receive cXML purchase or
ders, and send cXML invoices.

Learn about cXML cXML User’s Guide (available at http://www.cxml.org )

The definitive source for information on the cXML language. Describes how to send 
and receive cXML documents.
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How to create and publish catalogs

To create catalogs, you can download the CIF file template or the CIF and CXML example files that are available in 
the Ariba Network catalog wizard. The catalog wizard walks you through the process of naming, classifying, and 
transferring your catalog from your local drive and publishing it on Ariba Network after validation.

Prerequisites

● We recommend that you view your customer's catalog validation rules [page 22] before you upload a catalog. 
Validation checks the catalog for syntactic and semantic errors and also for compatibility with the catalog rules 
set by specific customers.

● Catalog filenames must contain only the following characters: A – Z, a – z, 0 – 9, period (.), dash (-), and 
underscore (_).

● If your customer wants you to upload advanced pricing details with your catalog, you must ensure that the 
catalog fields containing advanced pricing details don't violate syntactic validation rules, standards-based 
semantic validation rules, or a customer’s catalog rules.

● When using the catalog wizard, the catalog file can't exceed 95 MB or 400,000 lines.
● The CIF 2.1 catalog supports only a basic set of 12 fields. It doesn't support multi-language descriptions, multi-

currency pricing, multiple product commodity codes per line item, catalog expiration dates, PunchOut 
catalogs, or parametric searching parameters. These features require either CIF 3.0 or cXML catalogs.

● The maximum size of zipped Excel file that you can upload is 1 MB (uncompressed). If your Excel files exceed 
these size, you can convert them to CIF manually and upload the CIF files. Ariba Network uploads the file, 
unzips it if necessary, converts it to CIF format, and starts validation. Conversion from Excel to CIF can take 
several minutes depending on the catalog size. As Excel files convert, their status is Validating.

 Limitations
○ If you use the Ariba Network catalog wizard, the catalog file can't exceed 95 MB (400,000 line items). If 

you use the cXML CatalogUploadRequest transaction, the zipped catalog file cannot exceed 10 MB, 
and the unzipped CIF file cannot exceed 95 MB (approximately 400,000 line items). To have this 
default size limit increased to 200 MB, contact SAP Ariba Customer Support. Before uploading a 
catalog file in Excel format, be sure the catalog file does not exceed 1 MB.

○ Ariba Network doesn't retain the original Excel files you upload. After it converts them to CIF, it deletes 
them.

○ Ariba Network doesn't support CIF or cXML contract files, which are catalog files that contain pricing 
information only. Ariba Network currently supports index files, which contain both product and pricing 
information.

○ If your account is suspended, you can't publish cXML and CIF catalogs to specific customers.
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Procedure

1. On the home dashboard, click the Catalogs tab.
2. Click Create Standard to create a standard catalog. Ariba Network displays the first page of the Ariba Network 

create wizard.
3. Enter a unique catalog name and a brief description of your catalog. Customers can search for catalogs using 

this information.
4. To classify the products and services in your catalog, do the following:

a. Click Add in the Commodities section. Ariba Network shows the Product and Service Category Selection 
page, which lists product and service categories, based on the United Nations Standard Products and 
Services Code (UNSPSC).

b. On the Search tab, enter a keyword or search phrase and click Search, or click the Browse the Categories 
tab to drill down through commodity families, classes, and individual commodities.

c. Choose a product and service category level, and click Add. The My Selections area shows the selected 
product and service category level.

 Limitations
If you are a supplier of all the items in a given product and service category level, choose the name of 
the higher-level product and service category instead of adding all of the lower-level product and 
service categories. For example, a furniture supplier should choose the category “Furniture and 
Furnishings” not the hundreds of individual items it sells. Customers can search for this information.

d. To search for a product and service category by keyword, click the Search tab.
e. Enter a search keyword and click Search. Choose a check box to select a search result, and click Add.

The My Selections area shows the selected product and service category segment.
f. To remove a selected product and service category segment, choose the check box next to the product 

and service category segment in the My Selections area, and then click Remove.
g. Click OK.
h. Click Next.

The Subscriptions page in the catalog wizard lists only customers for whom the catalog is qualified. If you 
know customers are registered on Ariba Network, but you can't see them, contact them directly and ask 
them to grant you permission to see them.

5. Choose who should see your catalog:

○ Private: Ariba Network makes your catalog visible only to customers that you specify. You can choose this 
option for catalogs that contain contract prices. This option automatically creates a subscription to the 
catalog for all customers you choose.

○ Public: Ariba Network makes your catalog visible to all customers. To receive a catalog, a customer must 
establish a relationship with you.

 Note
If you set the visibility to Private, you can choose customers or customer groups, which creates the catalog 
subscriptions and automatically notifies the selected customers by email.

6. To punch in to your customer's site and view the catalog content rules specified by your customer, click the 
View link in the Catalog Validation Rules column.

Click Done to return to the catalog creation wizard on Ariba Network.
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7. Click Next to reach the Content page.
8. Click Browse to choose a catalog file to upload.

You can download the CIF file template [page 32] or the example files from this step.
9. Click Validate And Publish.

 Note
Large catalog files can take a long time to upload, depending on the speed of your network connection. 
When uploading very large catalogs, you might encounter timeout errors. To avoid these problems, you can 
zip your catalog files to compress them, which substantially decreases upload time. Zip catalogs in CIF and 
cXML format that are larger than 10 MB to avoid a timeout error. Ariba Network automatically unzips 
catalogs after upload. You can use any zip utility, such as WinZip. Each zip file can contain only one catalog, 
and the filename extension must be .zip.

Your web browser uploads the file to Ariba Network, validates and publishes it. Do not navigate in the browser 
window until the next page shows up, as interrupting your web browser aborts the upload process. Your 
customers are subscribed to the current catalog version and are notified of its availability.

Next Steps

After Ariba Network uploads the catalog, you can do the following:

● Review and fix CIF catalog errors [page 25] (for cXML catalogs, you must edit the catalog file and repeat the 
upload process)

● Qualify the catalog for additional customers
● Perform catalog management tasks, such as editing, downloading, and deleting catalogs

After Ariba Network completes validation, it changes the catalog status from Validating to one of the following 
statuses:

● Validated means that your catalog is error-free.
● Published means that your private catalog has been validated and published.
● Errors Found by means that Ariba Network detected catalog content that violates syntactic validation rules, 

standards-based semantic validation rules, or a customer’s catalog rules.
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Publishing catalogs for CMS-enabled 
customers

Some customers use the content management system (CMS) avaialble in SAP Ariba Procurement solutions to 
manage catalog data. You can upload and publish catalogs in CIF and BMEcat format for customers who use CMS 
to manage catalogs.

You can punch in to your customer's site to view content rules and validation errors [page 20] of catalogs that fail 
these rules. You can also edit and revalidate the catalog content within the customer's CMS.

Keep the following in mind when publishing catalogs for CMS-enabled customers:

● You can't upload catalogs in cXML format for CMS-enabled customers.
● When uploading private catalogs on Ariba Network, you can choose either CMS-enabled customers or 

customers who haven't enabled the CMS feature, but not a combination of both.
● You can't upload public catalogs for CMS-enabled customers.
● You can upload catalogs manually using the Ariba Network catalog wizard or programmatically using the cXML 

CatalogUploadRequest transaction.

Publishing catalogs to CMS-enabled customers involves the following high-level steps:

1. An SAP Ariba Customer Support representative enables this feature for your site and the customer's 
procurement site.

2. You create catalog files that describe products and services. You can download the CIF and BMEcat file 
templates or the example files that are available in the Ariba Network catalog wizard to create the catalogs.

3. You set the catalog visibility to Private and choose the CMS-enabled customers that you want to publish the 
catalog to.

4. You can punch in to each of your customer's sites to view their catalog content rules.
5. You return to the catalog creation wizard on Ariba Network, choose the catalog format, and upload the required 

catalog and image files.

 Note
Ariba Network doesn't check the catalog for syntactic and semantic errors.

6. The catalog file isn't uploaded to Ariba Network but is sent to the CMS in the customer's procurement site. The 
catalog is processed according to the content rules in the CMS.

7. Catalogs that fail any catalog rules set up by the customer in the CMS have a Validation Errors Found by 
Customer status on Ariba Network .

8. You can punch in to the customer's CMS, fix the errors, and revalidate the catalog.
9. Validated content documents are pushed from the CMS to the Catalog Manager workspace in the customer's 

site for master data validation, approval and activation.
10. The status of approved and activated catalogs is updated in the CMS and on Ariba Network.

Creating and managing catalogs
Publishing catalogs for CMS-enabled customers PUBLIC 17



How to upload and publish catalogs for CMS-enabled 
customers
You upload and publish private catalogs for your customers who use the CMS in SAP Ariba Buying solutions.

Prerequisites

● We recommend that you view your customer's catalog rules before you upload a catalog.
● When entering filenames for the catalog, you must ensure that the filenames don't contain any spaces or 

special characters.
● Ensure that the catalog file size doesn't exceed 200 MB.
● Ensure that the catalog images ZIP file size doesn't exceed 200 MB.

Procedure

1. On the home dashboard, click the Catalogs tab.
2. Click Create Standard to create a standard catalog.
3. Enter a unique catalog name and a brief description of your catalog. Customers can search for catalogs using 

this information.
4. To classify the products and services in your catalog, do the following:

a. Click Add in the Commodities section. Ariba Network shows the Product and Service Category Selection 
page, which lists product and service categories, based on the United Nations Standard Products and 
Services Code (UNSPSC).

b. On the Search tab, enter a keyword or search phrase and click Search, or click the Browse the Categories 
tab to drill down through commodity families, classes, and individual commodities.

c. Choose a product and service category level, and click Add. The My Selections area shows the selected 
product and service category level.

 Limitations
If you are a supplier of all the items in a given product and service category level, choose the name of 
the higher-level product and service category instead of adding all of the lower-level product and 
service categories. For example, a furniture supplier should choose the category “Furniture and 
Furnishings” not the hundreds of individual items it sells. Customers can search for this information.

d. To search for a product and service category by keyword, click the Search tab.
e. Enter a search keyword and click Search. Choose a check box to select a search result, and click Add.

The My Selections area shows the selected product and service category segment.
f. To remove a selected product and service category segment, choose the check box next to the product 

and service category segment in the My Selections area, and then click Remove.
g. Click OK.
h. Click Next.
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The Subscriptions page in the catalog wizard lists only customers for whom the catalog is qualified. If you 
know customers are registered on Ariba Network, but you can't see them, contact them directly and ask 
them to grant you permission to see them.

5. Set the catalog visibility to Private, and choose the customers that you want to publish the catalog to.

This step creates the catalog subscription and automatically notifies the customers by email. You can choose 
either CMS-enabled customers or customers who have not enabled the CMS feature, but not a combination of 
both.

6. To punch in to your customer's site and view the catalog content rules specified by your customer, click the 
View link in the Catalog Validation Rules column.

Click Done to return to the catalog creation wizard on Ariba Network.
7. Click Next to reach the Content page.
8. Choose the format of the catalog that you want to publish from the Select Format dropdown.
9. Click Browse to navigate to, and choose a catalog file.

You can compress and upload large catalog files in ZIP file format to avoid time-out errors. The maximum size 
of a catalog file is 200 MB.

10. Click Browse to navigate to and choose a catalog image file.

You can upload the catalog images file in ZIP file format only. Ensure that the path names you provide in your 
catalogs match the image directory structure. If you choose to zip the folder containing the images, the paths 
of the image files in the catalog file must contain the folder name. For more information, see the Catalog format 
reference.

The maximum size of a catalog images ZIP file that can be uploaded is 200 MB.
11. Click Validate And Publish.

 Caution
Don't navigate in your browser window until the next page appears. Interrupting your web browser stops 
the upload process.

Next Steps

The catalog file isn't uploaded to Ariba Network but is sent to the CMS in your customer's procurement site. The 
catalog is then processed according to the content rules in the CMS and moves to one of the following statuses.

Catalog subscription status Description

Pending Buyer Validation The catalog is uploaded successfully in SAP Ariba Buying solutions and is pending 
processing by the CMS.

Validation Errors Found by Customers The catalog violates one or more content rules specified in the CMS.

Validated The catalog is successfully uploaded in SAP Ariba Buying solutions and has passed 
all content rules, but isn't approved by the customer yet.
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Catalog subscription status Description

Approved The catalog is approved by the customer.

Rejected The catalog is rejected by the customer.

Activated The catalog is activated and available in SAP Ariba Buying solutions.

Deactivated A previously activated catalog version is now deactivated in SAP Ariba Buying solu
tions.

Deleted The catalog is deleted by the customer.

Changed The customer made some changes to the catalog.

How to view catalog validation errors
You view catalog validation errors in order to find out why a catalog failed and how to fix it.

Procedure

1. On the Catalogs tab, click the Validation Errors Found by Customer link in the Status column to punch in to 
your customer's site.

The page shows the total number of items that have been imported and the number of items that failed 
content rules, grouped by the following statuses: Validation Error, Validation Warning, Cleansed, and 
Enriched.

2. Expand each item status group to view the list of rules that caused failures and the item count per rule.
3. Click an item status link to view the items that are in that particular status. For example, click the Validation 

Error link to view the list of items with validation errors.
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How to fix errors and revalidate a catalog in your 
customer's site
You can punch in to the customer's site to edit catalogs that have errors and revalidate them.

Procedure

1. On the Catalogs tab, click the Validation Errors Found by Customer link in the Status column to punch in to 
your customer's site.

The page shows the total number of items that have been imported and the number of items that failed 
content rules.

2. Expand each item status group to view the list of rules that caused failures and the item count per rule.
3. Click Edit Content to edit the catalog.

The page shows the list of items in the catalog. Items that failed one or more catalog rule conditions are 
indicated by icons, and the associated field values are shown in red boxes.

4. You can use the options in the See All Items dropdown to narrow the list and view items that are in a particular 
status.
For example, choose See All Items > See Enriched Items to see only the list of items that have been enriched.

5. Click the value of the field that you want to edit, enter a new value, and click OK. Your changes are saved 
automatically.

 Note
You have to fix errors in each line individually. There is no provision to select multiple lines to edit catalog 
fields.

6. (Optional) Click Save to save your changes.
7. Click Revalidate to run the rules again and revalidate the entire catalog.
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Validation and statuses for catalogs

After you upload a catalog, Ariba Network validates the catalog to ensure that the catalog content is correctly 
formed. Then, Ariba Network publishes and qualifies the catalog for the designated customers. You can view the 
status of each catalog in the list on the Catalogs tab.

Validation by Ariba Network

Ariba Network validates the syntax and semantics of your catalog files:

● Syntactic validation ensures that a catalog’s content is correctly formed. For example, every catalog entry 
must have the correct number of fields and the content of each field must match the field’s data type. Every 
catalog file must be syntactically correct before you can publish it.
During syntactic validation, Ariba Network checks that:
○ All required fields are present.
○ No field exceeds its maximum field length.
○ All integers and decimals are formatted correctly.
○ Price formats are correct and a currency specified.
○ No two items have the same combination of Supplier ID, Supplier Part ID, and Supplier Part Auxiliary ID.
○ The character set specified in the file is valid.
○ CIF file headers begin with a CIF version number and end with a DATA token. The DATA and ENDOFDATA 

tokens must exist and be in the correct locations. The lines between must be of the form key:value. 
Additionally, Ariba Network displays an error if the itemcount field does not match the number of items in 
the file.

○ No invalid characters are present in any fields.
○ Descriptions are present. Ariba Network issues a warning if it encounters invalid characters in the 

Description field.
● Semantic validation ensures that a catalog’s content is compatible with specified catalog standards, such as 

UNSPSC commodity codes or standard unit of measure (UOM) codes. If you choose to qualify your catalog for 
a specific customer, Ariba Network validates it against that customer’s catalog rules. For example, if the 
customer’s procurement system uses a custom commodity code set and the catalog uses a standard 
commodity code set, Ariba Network can't validate the catalog for that customer. Your customers can choose to 
relax validation rules for UNSPSC, UOM, or zero price values.
During semantic validation, Ariba Network checks the units and codes listed below for each catalog item to 
ensure they are compatible with specified catalog standards.
○ Currency: An item’s currency must be valid. Ariba Network maps currencies to translate the incoming 

currency names into the customer’s procurement system’s standard currency terminology. A currency is 
not valid unless it meets the following criteria:
The value to which the code is mapped in the simple map has a corresponding Currency object. There are 
no empty values. Ariba Network generates an alert for items with zero or no cost.

○ Unit of measure (UOM): An item’s unit of measure must be valid based on the UOM code specified in the 
catalog header. If a catalog doesn't use the customer’s canonical units of measure, the customer must 
define a mapping file to be sure that the incoming terminology is interpreted correctly.
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○ Commodity code: An item must have at least one domain-specific commodity code that maps to a 
supported commodity code specified in the catalog header. You can override the commodity code at the 
line-item level. Ariba Network supports UNSPSC, eCl@ss, NAICS, and ISICS commodity codes, but only 
validates UNSPSC commodity codes. By default, Ariba Network uses ECCMA version 13.5 and UNSPSC 
version UNSPSC v9.0501. The UNSPSC codes used in catalogs support version 13.5.

○ Supplier ID: An item’s Supplier ID must match the ANID or D-U-N-S number of your supplier organization 
as specified in the catalog header file.

○ URL formats: The Supplier URL and Manufacturer URL must have http:// along with the URL string.
○ Start/Expiration Dates: The item’s Start Date must be before the expiration date.
○ Territory and Language: The Territory and Language codes must validate against the ISO 3166-1 and 

3166-2 codes and Java locale codes.

Your customers' catalog validation rules

To view your customers’ catalog validation rules, go to the Subscriptions page of the Ariba Network catalog wizard, 
and then click the View link in the Catalog Validation Rules column next to the customer's name.

Alternatively, you can punch into the customer's site to view the catalog preferences.

In some cases, when you punch in to the customer's site for the first time, you might see the following error 
message:

Cannot access customer's site. Your buying organization must approve your access to 
their system before you proceed with this action. Please try again later.

This error occurs when your customer hasn't approved your access to their procurement site. You should contact 
your customer to ask for access to their site.

 Note
Ariba Network doesn't validate catalogs published for CMS-enabled customers.

Validation errors on catalogs

After you upload a catalog file, the catalog might have errors that prevent it from being published to your 
customers.

To view details of the validation errors, do one of the following:

● Go to your customer's site to view the error details.
● Check the error information in email notifications sent by Ariba Network.
● On the Catalogs tab, click the Errors Found by Customer link in the Status column.

To resolve a catalog error [page 25], you can either upload a modified version of the catalog that meets your 
customer’s requirements or contact your customer to ask them to disable a requirement. After correcting catalog 
errors on Ariba Network, you must ensure that you make the same changes to the catalog file on your computer so 
the errors don't reappear.
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 Limitations
For cXML catalogs, you can't fix problems within your account. Instead, fix the file locally on your computer and 
click Update content to upload the updated version [page 28].

Catalog statuses

Use the following table to interpret the different catalog subscription statuses.

Status Description

Received, Pending Buyer Validation The catalog is uploaded successfully in SAP Ariba Buying solutions and is pending vali
dation from your customer. Catalogs published to all other procurement customers 
have a Published status.

Validation Errors Found by 
Customers

The catalog failed during validation against your customer’s catalog rules in SAP Ariba 
Buying solutions. To view details of the error, click the Validation Errors Found by 
Customer link for this catalog on the catalog dashboard and view details of the error 
message by punching into your customer’s site.

Validated The catalog is successfully uploaded in SAP Ariba Buying solutions and has passed vali
dation, but your customer hasn't approved it yet.

Approved Your customer approved the catalog.

Rejected Your customer rejected the catalog.

Activated Your customer activated the catalog and made it available in SAP Ariba Buying solu
tions.

Deactivated A catalog version activated earlier is now deactivated. Catalogs can change back and 
forth between Activated and Deactivated statuses.

Deleted Your customer deleted the catalog.

Changed Your customer made some changes to the catalog.
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How to correct errors in CIF files

You fix errors in your catalog files so you can reload them and publish them successfully to your customers.

Procedure

1. On the home dashboard, click the Catalogs tab.
2. Click a catalog name to view more information about it, or choose a catalog and click View/Edit.
3. Click the Errors Found status link.
4. To customize your view of the error list, click the table options icon in the upper right of the Catalog Validation 

Errors table, and then do one or all of the following:

○ To add or remove columns from view, check or uncheck them in the Show/Hide Columns section of the 
table menu.

○ To group errors by a specific column, choose the column name in the Group by Column section of the 
menu.

○ To export the errors to Excel, choose an option in the Export to Excel section of the menu.
5. When you are ready to view an error, click a line number or an error description.

If the error is in the catalog body, you're taken to a page where you can edit the line item.

If the error is in the catalog header, you'll see a text box for editing just the header.
6. For each error, enter a new value to replace the old value.

 Tip
For information about syntax for CIF files, see the Catalog format reference.

7. Click Update to submit your changes.

Ariba Network validates your changes and, if you selected a customer during upload, qualifies the catalog for 
that customer. It also revalidates the catalog against all qualified customers to ensure that you have introduced 
no new errors.

8. To delete a line from the catalog, do the following:

○ Click the Content page to view all the catalog items.
○ Click Delete in the Action column for the item that you want to delete.

The line is deleted and the status of the catalog is updated in the catalog dashboard.

Related Information

Validation and statuses for catalogs [page 22]
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How to edit CIF catalogs online

If you have a small catalog or only a few changes to make to an uploaded catalog, you might prefer to make the 
edits directly in the uploaded catalog instead of downloading the file and making the updates.

Prerequisites

● If you use Windows Notepad to edit catalogs, do not click the “Save as Unicode” check box. For the same 
reason, if you use Microsoft Word, do not select “Unicode Text” as the file type. Raw Unicode (also known as 
UCS-2) is not file-safe because its byte order varies depending on the operating system.

 Limitations
○ You can't edit catalogs over 4 MB in size online. Download large catalogs [page 30], edit them on your 

computer [page 26], and then upload them to Ariba Network.
○ You can't view or edit cXML catalogs online.
○ You can't edit Excel catalogs online; edit them on your computer in Microsoft Excel and upload them to 

your account.

Procedure

1. On the home dashboard, click the Catalogs tab.
2. Click the name of the catalog you want to edit, or choose the catalog and click View/Edit.
3. Click Next to view the Content step of the catalog wizard.

Ariba Network shows a list of line items in the catalog.
4. If the catalog you want to edit has already been published, you must create a new version to edit it. Click 

Create New Version, update the information on the Details page, and click Next.
5. Do one of the following:

○ To delete an item, click Delete in the Action column next to the item.
○ To add an item, click Add Item. You'll see a page where you can enter field values for the new item.

 Tip
For information about CIF syntax and format, see the Catalog format reference.

6. If you added or deleted any items, click Update Header Data on the Contents page to edit the catalog header 
details.

7. After updating the catalog header details, click Next.
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 Note
If Ariba Network finds any errors, they are indicated on the Errors page. Click the item number of the item 
with the error to correct it.

8. On the Subscriptions page, configure the catalog visibility.
9. Click Validate and Publish to publish the new version of the catalog.

Next Steps

After editing catalogs directly in your Ariba Network account, be sure to make the same changes to the catalog files 
on your computer so the old values don't reappear.
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How to update or delete your catalog files

You can update catalog files when there are updates to your offerings or pricing. When a catalog subscription no 
longer applies, you can delete if from Ariba Network.

Context

Keep the following points in mind when editing and uploading catalogs:

● You change the catalog by uploading another catalog. A new version of a catalog is created on Ariba Network 
when a catalog is edited or a new catalog file is uploaded. Ariba Network continues to store the previous 
versions of your catalog, but only the latest version is visible.

● Upload the entire updated catalog, not just the changes; Ariba Network doesn't merge partial catalogs.
● Avoid changing catalog formats (CIF or cXML). While Ariba Network doesn't prevent you from changing catalog 

formats during an update, it's important to use the same format for all versions of a catalog subscription.
● If the catalog contains numerous errors, it's easier to fix the original file and upload it again. If you update an 

existing catalog that Ariba Network validated in the past, it might no longer pass validation when you upload it 
because of one or both of the following:
○ Ariba Network’s semantic validation checking was less sophisticated.
○ Your customer’s catalog validation rules changed after you last validated the catalog.

● When updating a catalog, you don't need to create a new standard catalog.You can use an existing catalog, but 
make sure not to change the existing name for the catalog subscription when you upload a new version. This 
step is critical for your customer to be able to accurately update existing catalogs when a new version is 
available.

You can access previous versions of a catalog by deleting the current version. Deleting catalogs removes them from 
Ariba Network. Customers can no longer view them online or download them.

When a new version is created or a current version is deleted, Ariba Network sends an automatic notification to all 
customers that subscribed to it. Publishing your updated catalog sends automatic notification to any customers 
that subscribed to it. For private catalogs, customers receive notification only if you select them and they request 
notification. Customers that you don't select won't receive notifications, even if they request it.

Procedure

1. On the home dashboard, click the Catalogs tab.
2. Choose a catalog, and do one of the following:

○ To edit a catalog, click View/Edit.
○ To delete only the latest version of a catalog, choose Delete > Latest Version Only. Ariba Network reverts 

to the previous version of the catalog, if one exists.
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 Note
Use this feature if the latest version you uploaded has problems and you want to go back to the 
previous version or upload a new version.

○ To delete all versions of a catalog, choose Delete > All Versions. Ariba Network deletes all versions of the 
catalog and removes the catalog name.

3. To add product and service categories, click Add in the Commodities section, and then choose from the 
available product and service categories on the Product and Service Category page.

4. Click Next to view the Content step of the catalog wizard.

Ariba Network shows a list of line items in the catalog.
5. Click Upload Catalog File to replace the existing catalog file.
6. Click Browse to find the location of the catalog file on your computer.

 Tip
Use the same catalog filename for all versions of a catalog subscription. Using the same name makes 
catalog management easier for customers.

7. Click Validate and Publish to publish a new version of the catalog.

Related Information

How to edit CIF catalogs online [page 26]
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How to view and download your catalogs

You might want to download your catalogs from Ariba Network if you have lost your local catalogs or if you need to 
verify the contents of uploaded catalogs.

Prerequisites

To download catalogs, they must be in CIF 3.0 format and smaller than 600 KB. You can download catalogs as Excel 
files if they are in CIF 3.0 format and are smaller than 400 KB.

Procedure

1. On the home dashboard, click the Catalogs tab.
2. To change the information you want to display on the Catalog page, click the table options menu icon in the 

upper right corner of the Catalog table.
3. If you are viewing the catalog dashboard, interpret the columns using the following table:

Column name Description

Customer Name The name of the customer that has subscribed to that catalog.

The customer’s name is shown for each private catalog. None means it is a public catalog with 
no subscriptions. When a customer subscribes to a public catalog, the customer’s name shows 
up in this column. When multiple customers subscribe to the same public catalog, each sub
scription shows up as a new row with the name of that customer.

Catalog Name The unique name of the catalog.

Version The version number of the catalog.

When you edit or update an existing catalog, Ariba Network creates a new version and assigns a 
version number. Ariba Network continues to store the previous versions of your catalog, but only 
the latest version is visible. You can access previous versions by deleting the current version.

File Name The name of the catalog file.

Type The catalog file type. Catalog files must be CIF, cXML, or Excel files (.cif, .xml, .xls, or .zip).

Size The file size of the catalog.

Visibility Specifies whether a catalog is private or public.

Created By The name of the catalog creator.

Date Created The date the catalog was uploaded to Ariba Network.
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Column name Description

Status The catalog or subscription status of the catalog:
○ Catalog status: Whether the catalog was uploaded and published successfully on Ariba 

Network.
○ Subscription status: Whether the catalog passed validation in SAP Ariba Buying solutions. 

When the catalog fails validation in SAP Ariba Buying solutions, a status update is sent to 
Ariba Network and shown on the catalog dashboard. If Ariba Network doesn't receive a sta
tus update for the catalog, the Ariba Network catalog status remains.

Date Status Received The date the subscription status is received from SAP Ariba Buying solutions.

4. Do any of the following from the table options menu:

○ To add or remove columns from view, check or uncheck them in the Show/Hide Columns section of the 
table menu.

○ To group catalogs by a specific column, choose the column name in the Group by Column section of the 
menu.

5. Click the name of one of your catalogs, or choose a catalog and click View/Edit.
6. Click Next to view the Content step of the catalog wizard.
7. Click Download Catalog File.
8. Choose the preferred download option:

○ Download as cXML (available for cXML catalogs)
○ Download as CIF (available for CIF 2.1 and CIF 3.0 catalogs)
○ Download as Excel (available for CIF 3.0 catalogs smaller than 400 KB)

9. If the Download as Excel is grayed out:
a. Click Convert to Excel. This step starts the conversion process, which can take several minutes, depending 

on catalog size.
b. Wait for the conversion to complete. Click Refresh Status to see the current conversion status; when 

complete, the Download as Excel button becomes active.
c. Click Download as Excel.

If your browser prompts you to specify a location for storing the downloaded file, choose a folder on a local 
drive. If your web browser opens and displays the template, choose File > Save As and save the template 
to a local drive.

Related Information

How to update or delete your catalog files [page 28]
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Working with the Excel CIF template

If you prefer to manage catalog content with spreadsheets, SAP Ariba provides a Microsoft Excel template 
containing the required information and an Excel-to-CIF converter. The Excel format CIF template helps you fill in 
the various fields for items in your catalogs.

 Note
Your customer's purchasing system recognizes CIF files, but not Excel catalogs. To convert Excel catalogs to 
CIF, you can either use the Ariba Network Excel-to-CIF converter, or you can convert them yourself. It can also 
convert CIF files back to Excel format for downloading.

How to edit the Excel CIF template

Procedure

1. To get the CIF file template, create a new standard catalog, and find the template on the Content step of the 
catalog wizard.

2. After you download and save the template, open the file in Excel.

 Tip
The CIF template contains useful descriptions of each field. To read them, put your pointer on the red 
comment markers.

3. Review the catalog header to make sure the fields are correct. For example:

CODEFORMAT: UNSPSC CURRENCY: USD SUPPLIERID_DOMAIN: NETWORK ID

 Note
Specify currency names with ISO 4217 three-letter (CodeA) currency codes.

4. Enter your catalog data into the body fields.

 Remember
For each catalog item, you must enter values for the first seven fields (or columns). Ensure that your entries 
don't exceed the field sizes (the Excel CIF template contains comments that indicate the field size).

5. To calculate the number of catalog items for the ITEMCOUNT field, subtract the number of the last line of data 
from the number of the first line of data, and then add one.
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6. Save the file as an Excel (.xls) file.

How to open CIF files in Excel

Procedure

1. In Excel, choose File > Open.
2. Choose the CIF file.

Excel shows the Text Import Wizard.
3. Select Delimited and then click Next.
4. Select Comma as the delimiter and quote (") as the text qualifier.
5. Uncheck Tab.
6. Click Next.
7. Select all columns in your spreadsheet, select Text as the column data format, and then click Finish.

 Tip
Treat all columns as text so that Excel retains any leading or trailing zeros.

8. To make the resulting spreadsheet more readable, select all cells and choose Format > Column > AutoFit 
Selection.

How to save Excel files as CIF
To convert to CIF manually, you save the Excel file to CSV format and delete extra commas with a text editor.

Procedure

1. In Excel, choose File > Save As.
2. Select CSV (MS-DOS) as the file type.

Excel inserts a comma between each field.
3. Enter an meaningful name for the file.

 Example
The recommended format is <catalog_description>_<customer_name>; for example, 
workchairs_acme.
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4. Click Save.
5. To remove extra commas in the CIF file, open the file in Notepad, Wordpad, or another ASCII text editor.
6. Delete extra commas from the header and the body.
7. Ensure that the leading or trailing zeros weren't deleted.
8. Save the file.
9. Change the file extension from .csv to .cif.

Excel CIF template fields
The following table provides an overview of the fields that are available in the CIF template.

For each catalog item, you must enter the following values:

Field Description

Supplier ID Your Ariba Network ID (ANID) or D-U-N-S number:

● View your ANID at the bottom of any Ariba Network page or by clicking Company Settings in 
the upper right corner of your dashboard.

● Look up your organization’s D-U-N-S number on the Dun & Bradstreet website .

Item Description A description of the catalog item. Don't use abbreviations.

SPSC Code Enter the catalog item’s United Nations Standard Products and Services Code (UNSPSC). To find 
the appropriate code, search for catalog standards in the help center.

Ariba Network uses ECCMA version 13.5 and UNSPSC version UNSPSC v9.0501. The UNSPSC ver
sion UNSPSC v9.0501 corresponds to the ECCMA  version 13.5.

The commodity codes used in catalogs support ECCMA version 13.5. However, Ariba Network can 
translate any earlier version to 13.5 and vice versa.

Unit Price Enter the price per unit for the catalog item. Specify numbers as you want them to appear to users. 
For example, for $19.50, enter “19.50” (include the trailing zero). Do not include the currency symbol 
($).

Unit of Measure Enter the unit of measure for the catalog item using the United Nations Units of Measure (UNUOM) 
standard . For a list of UNUOM codes, search for UN UOM in the help center.
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How to set up a PunchOut catalog

PunchOut catalogs are interactive catalogs stored on your website that use cXML to enable two-way 
communication of electronic commerce details. A PunchOut catalog allows your customer's purchasing system to 
communicate with live catalog content on your website, which often provides a better shopping experience for your 
customers and reduces your workload.

Prerequisites

You must configure your cXML profile and specify the PunchOut Setup Request URL. Ariba Network uses this URL 
to send the PunchOut request documents. For more information about how to configure your cXML profile, see 
Configuring document routing.

Context

In your customer's purchasing system, PunchOut catalogs show a hyperlink instead of product or pricing details. 
When users click this hyperlink, their web browser leads them to a page from your local website.

Depending on how you implement this page, users can browse product options, specify configurations, and choose 
delivery methods. Your customer's system passes organization IDs to your website, and you can use them to look 
up previously agreed-upon prices (contract prices). When users finish with this page, they click a button that 
returns the order information to their purchasing system. The fully configured products and their prices appear 
within the purchasing system on users’ purchase orders.

PunchOut catalogs allow you to leverage existing resources from simple online catalogs to advanced e-commerce 
sites. PunchOut catalogs can also use search engines to find items on your website.

Use PunchOut catalogs for:

● Products with a large number of configurations and options; for example, many colors or sizes, or many 
delivery methods (overnight, two-day, or five-day).

● Inventories containing more than a few thousand items.
● Products whose prices are based on prearranged contracts (custom pricing).
● Products that must be customized for each customer, such as nameplates or business cards. (Alternatively, 

your customers can implement custom catalog forms in the purchasing system, which allow users to attach 
personalized data to a purchase order).

● Products whose specifications or prices change often.
● Products with advanced pricing details.

When deciding whether to use PunchOut catalogs, consider the following trade-off:

● They require all users to have full Internet access, which some companies don't allow.
● They require you to implement and maintain an interactive website, accessible 24 hours a day, seven days a 

week.
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If your account is suspended, your customers can still access your PunchOut catalogs, shop for products and 
services, and create a purchase order; however, Ariba Network doesn't send you the purchase order. For more 
information about suspended accounts, see Managing subscription services.

PunchOut catalog users don't need to enter a user password for your site. They are pre-authenticated by Ariba 
Network.

For information on how to implement a PunchOut website, see the cXML User’s Guide and the cXML Solutions 
Guide.

 Note
You must ensure that your PunchOut website’s use of cookies and online tracking is compliant with the General 
Data Protection Regulation (GDPR) and the ePrivacy Regulation (ePR).

SAP Ariba recommends that you use appropriate tools to test your site to ensure that it is GDPR and ePR 
compliant. These tools might indicate you to make changes such as, removing all external http references, and 
having a single cookie policy for site visitors.

Procedure

1. On the home dashboard, click the Catalogs tab.
2. Click Create PunchOut Only.
3. Enter information about your PunchOut catalog. Customers can search each of these fields. Note the following:

○ You must enter the prefix https:// for the PunchOut URL value. This URL is no longer used, but 
purchasing systems require a value for this field.

○ The UNSPSC field adds a commodity code to the PunchOut index catalog. The Commodities field allows 
you to classify the types of products or services you offer, which helps customers searching for specific 
products or services find your catalog. Click Add to get to the Product and Service Category Selection 
page. For more information about classifying commodities, see How to create and publish catalogs [page 
14].

 Limitations
Ariba Network uses ECCMA version 13.5 and UNSPSC version UNSPSC v9.0501. The UNSPSC codes 
used in catalogs support version 13.5. However, it can translate any earlier version to 13.5 and vice 
versa.

4. Click OK.

The PunchOut catalog is now validated and published.

 Note
Ariba Network now forwards all PunchOut requests to the URL specified in your cXML profile. To specify the 
PunchOut URL that is actually used, click Company Settings in the upper right corner of your home 
dashboard, and choose Electronic Order Routing. In the cXML Setup section, click Configure cXML 
setup.
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Results

You can review the status of the catalog [page 22] that has been published. If the catalog contains errors, correct 
the errors [page 25] and try to publish it again.
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Important Disclaimers and Legal Information

Hyperlinks
Some links are classified by an icon and/or a mouseover text. These links provide additional information.
About the icons:

● Links with the icon : You are entering a Web site that is not hosted by SAP. By using such links, you agree (unless expressly stated otherwise in your agreements 
with SAP) to this:

● The content of the linked-to site is not SAP documentation. You may not infer any product claims against SAP based on this information.
● SAP does not agree or disagree with the content on the linked-to site, nor does SAP warrant the availability and correctness. SAP shall not be liable for any 

damages caused by the use of such content unless damages have been caused by SAP's gross negligence or willful misconduct.

● Links with the icon : You are leaving the documentation for that particular SAP product or service and are entering a SAP-hosted Web site. By using such links, you 
agree that (unless expressly stated otherwise in your agreements with SAP) you may not infer any product claims against SAP based on this information.

Videos Hosted on External Platforms
Some videos may point to third-party video hosting platforms. SAP cannot guarantee the future availability of videos stored on these platforms. Furthermore, any 
advertisements or other content hosted on these platforms (for example, suggested videos or by navigating to other videos hosted on the same site), are not within the 
control or responsibility of SAP.

Beta and Other Experimental Features
Experimental features are not part of the officially delivered scope that SAP guarantees for future releases. This means that experimental features may be changed by SAP at 
any time for any reason without notice. Experimental features are not for productive use. You may not demonstrate, test, examine, evaluate or otherwise use the 
experimental features in a live operating environment or with data that has not been sufficiently backed up.
The purpose of experimental features is to get feedback early on, allowing customers and partners to influence the future product accordingly. By providing your feedback 
(e.g. in the SAP Community), you accept that intellectual property rights of the contributions or derivative works shall remain the exclusive property of SAP.

Example Code
Any software coding and/or code snippets are examples. They are not for productive use. The example code is only intended to better explain and visualize the syntax and 
phrasing rules. SAP does not warrant the correctness and completeness of the example code. SAP shall not be liable for errors or damages caused by the use of example 
code unless damages have been caused by SAP's gross negligence or willful misconduct.

Bias-Free Language
SAP supports a culture of diversity and inclusion. Whenever possible, we use unbiased language in our documentation to refer to people of all cultures, ethnicities, genders, 
and abilities.
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